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Virtual Reality Toolbox™ Release Notes

Summary by Version

This table provides quick access to what’s new in each version. For
clarification, see “Using Release Notes” on page 2.

Version New Features | Version Fixed Bugs Related
(Release) and Changes Compatibility and Known Documentation
Considerations | Problems at Web Site
Latest Version | Yes None Bug Reports Printable Release
V4.8 (R2008b) Details Includes fixes Notes: PDF
Current product
documentation

V4.7 (R2008a) Yes None Bug Reports No

Details Includes fixes
V4.6 (R2007b) Yes None Bug Reports No

Details Includes fixes
V4.5 (R2007a) Yes No Bug Reports No

Details Includes fixes
V4.4 (R2006b) Yes Yes Bug Reports No

Details Summary Includes fixes
V4.3 (R2006a) Yes No Bug Reports No

Details Includes fixes
V4.2.1 (R14SP3) | No No Bug Reports No

Includes fixes

V4.2 (R14SP2+) | Yes No Known problems | No

Details
V4.1 (R14SP2) Yes No Fixed bugs No

Details
V4.0.1 (R14SP1) | No Yes Fixed bugs No

Summary

V4.0 (R14) Yes No Fixed bugs No

Details
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Version New Features | Version Fixed Bugs Related
(Release) and Changes Compatibility | and Known Documentation
Considerations | Problems at Web Site
V3.1 (R13SP1) Yes No Known problems | No
Details
V3.0 (R13) Yes Yes No bug fixes No
Details Summary

Using Release Notes
Use release notes when upgrading to a newer version to learn about:

* New features

e Changes

® Potential impact on your existing files and practices

Review the release notes for other MathWorks™ products required for this

product (for example, MATLAB® or Simulink®) for enhancements, bugs, and
compatibility considerations that also might impact you.

If you are upgrading from a software version other than the most recent one,
review the release notes for all interim versions, not just for the version you

are installing. For example, when upgrading from V1.0 to V1.2, review the
release notes for V1.1 and V1.2.

What'’s in the Release Notes
New Features and Changes

e New functionality

¢ Changes to existing functionality



Summary by Version

Version Compatibility Considerations

When a new feature or change introduces a reported incompatibility between
versions, the Compatibility Considerations subsection explains the
impact.

Compatibility issues reported after the product is released appear under
Bug Reports at the MathWorks Web site. Bug fixes can sometimes result in
incompatibilities, so you should also review the fixed bugs in Bug Reports
for any compatibility impact.

Fixed Bugs and Known Problems

The MathWorks offers a user-searchable Bug Reports database so you can
view Bug Reports. The development team updates this database at release
time and as more information becomes available. This includes provisions
for any known workarounds or file replacements. Information is available
for bugs existing in or fixed in Release 14SP2 or later. Information is not
available for all bugs in earlier releases.

Access Bug Reports using your MathWorks Account.
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http://www.mathworks.com/support/bugreports/
http://www.mathworks.com/support/bugreports/
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Version 4.8 (R2008b) Virtual Reality Toolbox

This table summarizes what is new in Version 4.8 (R2008b).

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes None Bug Reports Printable Release

Details below Includes fixes Notes: PDF

Current product
documentation

New features and changes introduced in this version are:

“New VR Tracer Block” on page 4
“Updated vrnode Method” on page 4

“New vrworld Method” on page 4

“New Demo” on page 4

New VR Tracer Block

New VR Tracer block enables visualization of trajectories in virtual scenes.

Updated vrnode Method

The vrnode method now reflects support for the VRML USE reference.

New vrworld Method

The vrworld/addexternproto method is new for vrworld. This function
enables the addition of an EXTERNPROTO declaration to the virtual world.

New Demo

The vrtkoff_spacemouse demo is new in this release. It illustrates how to
use a space mouse compatible device via the MATLAB interface. This demo
requires a space mouse or compatible device.
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Version 4.7 (R2008a) Virtual Reality Toolbox™

Version 4.7 (R2008a) Virtual Reality Toolbox

This table summarizes what is new in Version 4.7 (R2008a):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes None Bug Reports No

Details below Includes fixes

New features and changes introduced in this version are:

e “VR Sink Block Now Supports Matrix Signals as Input” on page 5
¢ “New vrworld Object Option” on page 5
¢ “Enhanced vrplay Shortcut Keys” on page 5

¢ “New Demos” on page 6

VR Sink Block Now Supports Matrix Signals as Input
The Virtual Reality Toolbox™ product now supports matrix-type data input
for the VR Sink block. Previously, only the MATLAB interface supported
matrices (MFxx fields). The Simulink interface supported only vectors (SFxx
fields). Now, both MATLAB and Simulink interfaces support matrices (MFxx
fields).

New vrworld Object Option

The vrworld object has a new option, new. This option enables the creation
of a new virtual world object, even if another vrworld object associated with
the same VRML file already exists.

Enhanced vrplay Shortcut Keys

The vrplay function shortcut keys have changed as follows:

¢ The Page Up and Page Down keys have the same functionality as the R
(rewind) and F (forward) shortcut keys, respectively. These keys perform
rewind and forward operations on the animation file you are playing.


http://www.mathworks.com/support/bugreports/?product=VR&release;=R2008a
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® The p shortcut key toggles between play and pause behavior.

New Demos
The following demos are new in this release:

® vrmorph
e vr_octavia_video

®* vrtkoff_trace



Version 4.6 (R2007b) Virtual Reality Toolbox™

Version 4.6 (R2007b) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.6 (R2007b):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes None Bug Reports Printable Release

Details below Includes fixes Notes: PDF

Current product
documentation

New features and changes introduced in this version are

New VR To Video block

New VR To Video block allows RGB video stream output for further 2D
video processing.

Joystick and Space Mouse Input Functionality Added
to MATLAB Toolbox Interface

New vrjoystick and vrspacemouse objects can interface with joysticks and
space mouse input devices.

Joystick and Space Mouse Input Support Added for
Linux

Joystick and space mouse input support is added for both 32-bit and 64-bit
Linux® operating systems.

New Axes Transformation and Math Functions

New axes transformation and math functions are added to the MATLAB
toolbox interface. These are:

® vrdir2ori to convert viewpoint direction to orientation.
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vrori2dir to convert viewpoint orientation to direction.

® vrrotmat2vec to convert rotation from matrix to axis-angle representation.
® vrrotvec to calculate a rotation between two vectors.

® vrrotvec2mat to convert rotation from axis-angle to matrix representation.

Magellan Space Mouse Block Renamed to Space

Mouse Input
The Magellan Space Mouse block is renamed to Space Mouse Input.



Version 4.5 (R2007a) Virtual Reality Toolbox™

Version 4.5 (R2007a) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.5 (R2007a):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes No Bug Reports No

Details below

Includes fixes

New features and changes introduced in this version are

Full Screen Mode in Virtual Reality Toolbox Viewer

and Orbisnap Stand-Alone Viewer

Fullscreen mode, in which the menu bar and toolbar are switched off,
is implemented in the Virtual Reality Toolbox viewer and the Orbisnap
stand-alone viewer.


http://www.mathworks.com/support/bugreports/?product=VR&release;=R2007a
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Version 4.4 (R2006b) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.4 (R2006b):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes Yes—Details labeled Bug Reports No

Details below

as Compatibility

Includes fixes

Considerations,
below. See also
Summary

New features and changes introduced in this version are

VR Text Output Block Added

The VR Text Output block allows Simulink signal values to be displayed as
text in VRML scenes.

Frames Per Second Added to AVI File Playback
Options

It is now possible to specify the frames per second displayed during the
playback of AVI files.

New 3Dconnexion Devices

SpacePilot and SpaceBall 5000 have been added to the list of devices
supported by Magellan Space Mouse block.

Joystick Input Block

The Joystick Input block joystick yaw and throttle controls have switched
behaviors.


http://www.mathworks.com/support/bugreports/?product=VR&release;=R2006b
http://www.mathworks.com/support/bugreports/?product=VR&release;=R2006b

Version 4.4 (R2006b) Virtual Reality Toolbox™

Compatibility Considerations

If you have models that contain this block, and you want to use that model
in a Virtual Reality Toolbox version later than 4,3, you must reorder the
axes. You can do so by placing the Simulink Selector block after the Joystick
Input block in the model.

11
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Version 4.3 (R2006a) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.3 (R2006a):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes No Bug Reports No

Details below

Includes fixes

New features and changes introduced in this version are

New Utilities Library

A new library Utilities is added to the Virtual Reality Toolbox block
library vrlib. This library contains the blocks Rotation Matrix to VRML
Rotation, Viewpoint Direction to VRML Orientation, Rotation between
2 Vectors, Normalize Vector, and Cross Product. See “Block Reference”
for details.

VR Animation Playback Controls

A new vrplay GUI is added, which allows playback control of VRML
animation files


http://www.mathworks.com/support/bugreports/?product=VR&release;=R2006a
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Version 4.2.1 (R14SP3) Virtual Reality Toolbox™

Version 4.2.1 (R14SP3) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.2.1 (R14SP3):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

No No Bug Reports No

Includes fixes

13
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Version 4.2 (R14SP2+) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.2 (R14SP2+):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes No Known problems No

Details below

New features and changes introduced in this version are

Virtual Reality Toolbox Support of MATLAB Compiler
Product

The Virtual Reality Toolbox product now supports the MATLAB® Compiler™
product. With this capability, you can use the MATLAB Compiler software to
take M-files as input and generate redistributable, stand-alone applications
that include Virtual Reality Toolbox functionality, including the Virtual
Reality Toolbox viewer. The Virtual Reality Toolbox product does not support
the MATLAB Compiler product for the HP-UX platform.

Virtual Reality Toolbox Viewer
The following changes were made to the viewer:

¢ The Virtual Reality Toolbox viewer Recording menu has changed to

support frame captures in addition to animation recording.

® The Virtual Reality Toolbox toolbar now has a camera icon that you can

click to capture a frame of the current virtual scene.

Virtual Reality Toolbox Preferences Dialog

The Virtual Reality Toolbox preferences dialog, available through the
MATLAB desktop File -> Preferences dialog, has been updated as follows:

® The Virtual Reality Figure pane is now organized by tabs.



Version 4.2 (R14SP2+) Virtual Reality Toolbox™

® The Virtual Reality Toolbox preferences dialog now provides frame capture
preferences. These are available through the Frame Capture tab of the
Virtual Reality Figure pane.

vrsetpref and vrgetpref Changes

The vrfigure set and get functions now include the following properties
to support frame capturing:

® CaptureFileFormat

® CaptureFileName

Space Mouse Block Enhancement

The Magellan Space Mouse block now allows you to specify upper and lower

position coordinate limits for the mouse. The following parameters were
added:

* Limit position — Determines whether you can limit the upper and lower
positions of the mouse.

* Lower position limit — Position coordinates for the lower limit of the
mouse.

e Upper position limit — Position coordinates for the upper limit of the
mouse.

15
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Version 4.1 (R14SP2) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.1 (R14SP2):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes No Fixed bugs No

Details below

New features and changes introduced in this version are

Virtual Redlity Toolbox Stand-Alone Viewer

The Virtual Reality Toolbox product now includes Orbisnap. This is a free,
optional, and multiplatform stand-alone VRML viewer that does not require
you to have either MATLAB or Virtual Reality Toolbox products. You can
use Orbisnap to

e View prerecorded WRL animation files

* Remotely view, from a client machine, a virtual world loaded in a current
session of the Virtual Reality Toolbox software

® View and navigate, but not simulate, a VRML world or scene

Virtual Reality Toolbox Viewer

The Virtual Reality Toolbox viewer now allows you to interactively set the
vrfigure maximum texture size through the Rendering menu.



Version 4.0.1 (R14SP1) Virtual Reality Toolbox™

Version 4.0.1 (R14SP1) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.0.1 (R14SP1):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

No Yes—Details labeled Fixed bugs No

as Compatibility
Considerations,
below. See also
Summary.

VR Source block

The VR Source block has been removed from the Virtual Reality Toolbox
product.

Compatibility Considerations

If you had models that made use of this block, you will need to remove any
references to it before your model will simulate using this release.

17
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Version 4.0 (R14) Virtual Reality Toolbox

This table summarizes what’s new in Version 4.0 (R14):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes No Fixed bugs No

Details below

New features and changes introduced in this version are

“Improved Overall Performance” on page 19

“Tracing and Offline Animation Files” on page 19

“Improved Virtual Reality Toolbox Viewer” on page 20
“Double-Clicking VR Sink Blocks Behavior Changed” on page 21

“Extended Support of Data Types” on page 21

“Improved Timing Control” on page 22

“HP-UX Platform Support” on page 22

“New vrfigure Object Functions” on page 22

“Joystick Input and Magellan Space Mouse Block Updates” on page 23

“New and Updated Demos” on page 23

“Virtual Reality Toolbox Simulink Blocks Updates” on page 23
“VR Sink and VR Source Block Source File” on page 24
“MATLAB Interface Updates” on page 24

“Preferences Changes” on page 24

“vrworld Object Property Updates” on page 28

“vrfigure Object Property Updates” on page 29
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Improved Overall Performance

Infrastructure changes have improved the overall performance of the Virtual
Reality Toolbox software.

Tracing and Offline Animation Files

The Virtual Reality Toolboxproduct enables you to record animations of
virtual scenes that are controlled by the Simulink or MATLAB products.
You can then later play back these animations offline (in other words,
independent of the MATLAB, Simulink, or Virtual Reality Toolbox). You can
save animation data in the following formats:

¢ 3-D VRML — The Virtual Reality Toolbox software traces object
movements and saves that data into a VRML file using VRML97 timers
and position/orientation interpolators. During the simulation, the product
creates interpolators and saves key and interpolation data values for
all the controlled movable objects in the scene. After the simulation is
stopped, the product saves the entire original VRML scene with the added
timers/interpolators into a user-specified VRML file.

You can then view these files with the Virtual Reality Toolbox viewer. 3-D
VRML files typically use much less disk space than Audio Video Interleave
(AV]) files. If you make any navigation movements in the Virtual Reality
Toolbox viewer while recording the animation, the Virtual Reality Toolbox
software does not save any of these movements.

¢ 2-D AVI — The Virtual Reality Toolbox software traces object movements
and writes animation data into an Audio Video Interleave (AVI) file using
the Virtual Reality Toolbox vrfigure/capture method and the MATLAB
avifile function. Because avifile can record the exact 2-D snapshot
of each figure window, the recorded 2-D animation reflects exactly what
you see in the viewer window. It includes any navigation movements you
make during the recording.

This functionality has been integrated into the Virtual Reality Toolbox viewer.
You can also save animation data through the MATLAB interface. This
functionality has been integrated into the vrworld and vrfigure methods.

See “MATLAB Interface” in the Virtual Reality Toolbox User’s Guide
documentation for procedures on how to save animation data.

19
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Notes when working with animation data:

¢ If you distribute the resulting VRML animation file, be sure to also
distribute all the inlined object and texture files referenced in the original
VRML world file.

¢ While recording 2-D AVI animation data, always ensure that the Virtual
Reality Toolbox viewer is the topmost window and fully visible. Graphics
acceleration limitations might prevent the proper recording of 2-D
animation otherwise.

® For the creation of animation files, timing is an important issue. When you
create animation files that are controlled from the Simulink interface, the
timing properties that control when the recording is started and stopped,
and when each data snapshot (3-D) or animation frame (2-D) is saved, are
related to the Simulink time. To better capture the scene dynamics, you
might want to change the Sample time parameter of the VR Sink block
parameter.

When you create animation files that are controlled from the MATLAB
interface, you need to programmatically advance the time in the virtual
scene.

Improved Virtual Reality Toolbox Viewer

The Virtual Reality Toolbox viewer has been completely updated and
improved. In addition to the original Navigation Panel at the bottom of
the window, the Virtual Reality Toolbox viewer now has a menu bar and
associated toolbar. These additional areas allow you to perform a number of
operations on the loaded virtual world, including

e Start the V-Realm Builder editor

® Perform navigation and rendering operations

e Work with, add, and remove viewpoints

e Start and stop model simulation

e Edit VR block parameters

® Record animations of the model simulation. You can later play back the
animation files without Virtual Reality Toolbox or other MATLAB product.
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In addition, the Virtual Reality Toolbox software has been enhanced for better
VRML97 compatibility, including:

¢ Proper handling of PROTO nodes
® Improved VRMLScript processing

® Improved texture rendering, allowing for resolution to the hardware limit
of your video card

® Improved rendering of transparent images

In addition, the Virtual Reality Toolbox viewer keyboard navigation has
changed.

Double-Clicking VR Sink Blocks Behavior Changed

The behavior of a VR Sink block when you double-click it has changed as
follows:

1 The first time you add a VR Sink block to a model, double-clicking that
block displays the block parameter dialog for that block.

2 After configuration is complete and you make an association with a virtual
world, double-clicking the VR Sink block displays the Virtual Reality
Toolbox viewer for that model.

To display the block parameter dialog for the VR Sink block in the
Virtual Reality Toolbox viewer, select the Simulation menu, then Block
Parameters.

Extended Support of Data Types

The Virtual Reality Toolbox product now supports a number of MATLAB
data types. In earlier releases, the MATLAB product only supported a data
type of double. The Virtual Reality Toolbox product provides an interface
between the MATLAB and Simulink environment and VRML scenes. With
this interface, you can set and get the VRML scene node field values. The
setfield and getfield vrnode methods have been updated to work with
these new data types.

21
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Improved Timing Control

The time in virtual scenes advances independently of MATLAB and Simulink
interfaces. As a result, if you define dynamic actions directly in the VRML
world, these actions cannot interact appropriately with object actions
controlled by Virtual Reality Toolbox through the MATLAB or Simulink
interface. To compensate for this, the Virtual Reality Toolbox product now
provides two vrworld properties, Time and TimeSource. The Time property
contains the current time in the virtual world. The TimeSource property
defines the source of the time for the virtual world. The TimeSource property
can take the following values:

e 'external' — This is the default value. This property value specifies
that an external source controls the time in a virtual world (in other
words, all Virtual Reality Toolbox viewer windows). This external
source can be either from the Simulinkinterface, using the simulation
time, or from the MATLABiInterface, using the vrworld method
set(w,'Time',time _value). The 'external' property value eliminates
the unpredictable interferences between the Simulink software and
internal virtual world time and ambiguities in interpreting the time in
the virtual world.

e 'freerun' — This property value specifies that the time in virtual worlds
advances independently based on the system timer. You can still set the
time from which the virtual world clock starts advancing with the vrworld
method set(w, 'Time',time_value).

HP-UX Platform Support

The Virtual Reality Toolbox product is now supported on Hewlett-Packard™
UNIX® (HP-UX) 11.00.

New vrfigure Object Functions
The vrfigure object has two new methods:

¢ vrgcf — Gets the handle for a currently active virtual reality figure. It is
most useful to query and set virtual reality figure properties.

¢ vrgcbf — Gets the current callback virtual reality figure.
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Joystick Input and Magellan Space Mouse Block
Updates

When you place the Joystick Input and Magellan Space Mouse blocks in
disabled subsystems, these blocks no longer require that actual hardware be
connected to the computer for the model to run. This allows you to create
models with alternative user interfaces, switchable according to the actual
hardware configuration.

New and Updated Demos

New and updated demos in Release 14 are listed in the table below. You can

open the demos by entering the corresponding model names in the MATLAB
Command Window.

Title Model Name
Portal Crane with Joystick Control vrcrane_joystick
Portal Crane with Predefined vrcrane_traj
Trajectory

Heat Transfer Visualization with vrheat_anim

2-D Animation

Vehicle Dynamics Visualization vr_octavia

Virtual Redlity Toolbox Simulink Blocks Updates

The Simulink block library for the Virtual Reality Toolbox product has the
following block updates:

¢ VR Sink blocks now accept all meaningful data types as input. It converts
these data types to natural VRML types as necessary. These data types

include logical values, many types of signed and unsigned integers, singles,
and doubles.

¢ VR Source blocks now output signals of data types corresponding to the
natural VRML data types of the associated fields. These data types include

logical values, many types of signed and unsigned integers, singles, and
doubles.
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® Space Mouse Input blocks now support USB devices (such as the SpaceBall
input device), and the SpaceTraveler motion controller.

e Joystick Input blocks now support force-feedback devices such as
force-feedback joysticks, steering wheels, and haptic devices. To use this
functionality, you must install DirectX® Version 8.0 or later.

VR Sink and VR Source Block Source File

The behavior of the VR Sink and VR Source block Source file text field has
changed as follows:

* Browsing to a file enters that filename in the text field, with a path relative
to the Simulink model location. For example, if the VRML file resides in
<Simulink model location>\vrml\vrbounce.wrl, the filename that
appears in the text field is vrml\vrbounce.wrl.

e If a model has a VRML file associated with it, the Virtual Reality Toolbox
product searches the path associated with that file. If the product does
not find the file on this path, it then searches for the filename using the
MATLAB path value.

e If you enter an absolute and fully qualified path for the VRML file, the
Virtual Reality Toolbox software searches just that path for the file.

MATLAB Interface Updates

Associated with the support of extended data types, the MATLAB interface
vrsetpref and vrgetpref functions now set and get the following new
preferences in addition to earlier preferences.

Preferences Changes
The Virtual Reality Toolbox software lets you specify preference settings

so that you can define the default behavior of the Virtual Reality Toolbox
software. The preferences functionality has the following changes:

® The ability to set Virtual Reality Toolbox preferences has moved from
the VR Sink/Source blocks to the standard MATLAB preference system
accessible through the MATLAB main window File -> Preferences menu
item.
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For this release, you can set only the preferences for HttpPort,
VrPort, Editor, and TransportBuffer preferences using the MATLAB
Preferences menu. To get or set the full set of preferences, use the
functions vrgetpref and vrsetpref.

The following preferences have been added to the Virtual Reality Toolbox
software. For preferences that begin with the string DefaultFigure or
DefaultWorld, these values are the default values for the corresponding
vrfigure or vrworld property.

Preference Description

DataTypeBool Specifies the handling of

the VRML Bool data type

for vrnode/setfield and
vrnode/getfield. Valid values
are 'logical' and 'char'. If set
to 'logical', the VRML Bool data
type is returned as a logical value.
If set to 'char', the Bool data type
is returned 'on' or 'off'. Default
is 'logical’.

DataTypeInt32 Specifies handling of the

VRML Int32 data type

for vrnode/setfield and
vrnode/getfield. Valid values
are 'int32' and 'double'. If set
to 'int32', the VRML Int32 data
type is returned as int32. If set to
‘double’, the Int32 is returned as
"double'. Default is 'double’.
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Preference

Description

DataTypeFloat

Specifies the handling of

the VRML float data type

for vrnode/setfield and
vrnode/getfield. Valid values
are 'single’' and 'double'. If set
to 'single', the VRML Float and
Color data types are returned as
'single'. If set to 'double’, the
Float and Color data types are
returned as 'double'. Default is
‘double’.

DefaultFigureAnti
Aliasing

Determines whether antialiasing is
used by default for new vrfigure
objects. Valid values are 'off' and
‘on'.

DefaultFigureDeleteFcn

Specifies the default callback
invoked when closing a vrfigure
object.

DefaultFigureLighting

Specifies whether the lights are
rendered by default for new
vrfigure objects. Valid values are
'off' and 'on'.

DefaultFigureMax
TextureSize

Specifies the default maximum
pixel size of a texture used in
rendering new vrfigure objects.
Valid values are 'auto' and 32 <=
x <= video card limit, where x is a
power of 2.

DefaultFigureRecord2D
CompressMethod

Specifies the default compression
method for creating 2-D animation
files for new vrfigure objects.
Valid values are '', 'auto’,
'lossless', and 'codec_code'.
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Preference

Description

DefaultFigureRecord2D
CompressQuality

Specifies the default quality of 2-D
animation file compression for new
vrfigure objects. Valid values are
0-100.

DefaultFigureRecord2D
FileName

Specifies the default 2-D offline
animation file name for new
vrfigure objects.

DefaultFigureStatusBar

Specifies whether the status bar
appears by default at the bottom of
the Virtual Reality Toolbox viewer
for new vrfigure objects. Valid
values are 'off' and 'on'.

DefaultFigure
Transparency

Specifies whether or not
transparency information is

taken into account when rendering
for new vrfigure objects. Valid
values are 'off' and 'on'.

DefaultFigureWireframe

Specifies whether objects are drawn
as solids or wireframes by default
for new vrfigure objects. Valid
values are 'off' and 'on'.

DefaultWorldRecord3D
FileName

Specifies the default 3-D animation
file name for new vrworld objects.

DefaultWorldRecordMode

Specifies the default animation
recording mode for new vrworld
objects. Valid values are 'manual'’
and 'scheduled’.

DefaultWorldRecord
Interval

Specifies the default start and
stop times for scheduled animation
recording for new vrworld objects.

Valid value is a vector of two
doubles.

27



Virtual Reality Toolbox™ Release Notes

Preference

Description

DefaultWorldRemoteView Specifies whether the virtual world

is enabled by default for remote
viewing for new vrworld objects.
Valid values are 'off' and 'on'.

DefaultWorldTimeSource Specifies the default source of

the time for new vrworld objects.
Valid values are 'external' and
"freerun'.

TransportTimeout

Amount of time VR server waits

for a reply from the client. If there
is no response from the client, VR
server disconnects from the client.

vrworld Object Property Updates

Associated with the support of animation files, the vrworld object now
supports the following new properties:

Property

Description

Record3D

Enables 3D animation recording. Read/write.

Record3DFileName

3D animation file name. The string can contain
tokens that are replaced by the corresponding
information when the animation recording takes
place. Read/write.

Recording

Animation recording toggle. This property acts as
the master recording switch. Read/write.

RecordMode

Animation recording mode. Read/write.

RecordInterval

Start and stop times for scheduled animation
recording. Corresponds to the virtual world object
Time property. Read/write.
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Property Description
Time Current time in the virtual world. Read/write.
TimeSource The source of the time for the virtual world. If

set to 'external', time in the scene is controlled
from the MATLAB interface (by setting the Time
property) or the Simulink interface (simulation
time), if set to 'freerun', time in the scene
advances independently based on the system timer.
Read/write.

vrfigure Object Property Updates

The vrfigure object now supports the following new properties:

Property

Description

MaxTextureSize

Sets the maximum pixel size of a texture used
in rendering vrfigure objects. The smaller
the size, the faster the texture can render.
Increasing this value improves image quality
but decreases performance. A value of 'auto'
sets the maximum possible pixel size. If the
value you enter is unsuitable, a warning might
trigger. The Virtual Reality Toolbox software
then automatically adjusts the property to the
next smaller suitable value. Read/write.

NavMode

Specifies navigation mode. Read/write.

NavSpeed

Specifies navigation speed. Read/write.

NavZones

Toggles navigation zones on/off. Read/write.

Record2D

Enables 2-D offline animation file recording.
Read/write.

Record2DCompress
Method

Specifies the compression method for creating
2-D animation files. The codec_code must be
registered in the system. See the MATLAB
function documentation for avifile. Read/write.
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Property

Description

Record2DCompress
Quality

Specifies the quality of 2-D animation file
compression. Read/write.

Record2DFileName

Specifies the 2-D offline animation file name. The
string can contain tokens that are replaced by the
corresponding information when the animation
recording takes place. Read/write.

StatusBar

Toggles the status bar at the bottom of the
Virtual Reality Toolbox viewer. Read/write.

Toolbar

Toggles the toolbar on the Virtual Reality Toolbox
viewer. Read/write.
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Version 3.1 (R13SP1) Virtual Reality Toolbox

This table summarizes what’s new in Version 3.1 (SP1):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes No Known problems No

Details below

New features and changes introduced in this version are

Cross-Platform Support

The Virtual Reality Toolbox product is now supported on the Mac OS® X
platform.

Improved Rendering
The overall rendering of virtual worlds for the Virtual Reality Toolbox

interface is improved.

Known Problems

Microsoft Internet Explorer 6.0

Microsoft® Internet Explorer® 6.0 might incorrectly interpret system Java™
library paths, preventing Virtual Reality Toolbox components (such as the
Virtual Reality Toolbox Viewer) from running. Netscape Navigator® users do
not experience this problem.

If you are using Internet Explorer 6.0, you should manually edit the Java

library path for Internet Explorer 6.0. Alternatively, you can also use Internet
Explorer 5.5 with Virtual Reality Toolbox software.

Editing the Java Library Path

To manually edit the Java library path for Internet Explorer 6.0:
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1 Run the regedit command.
2 Goto

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\JavaVvM

A list of value names and their values appears.

3 Replace each instance of %systemroot% with the system root path. For
example

C:\WINNT

4 Restart the computer.

Patch Required for the MATLAB Product Running Mac OS X
10.2

The Virtual Reality Toolbox product requires the MATLAB product running
Mac OS X 10.2.

To install the Virtual Reality Toolbox product on Mac OS X, you must first
install a patch available from The MathWorks. To get the patch, go to
ftp://ftp.mathworks.com/pub/tech-support/solutions/s33053. Refer to
this location for any updates. Refer to http://www.mathworks.com/support
for updated instructions. The instructions for this patch are below.

You should download this patch if you match one of these scenarios:

® You want to install MATLAB Release 13 on a Mac OS X 10.2 system that
does not currently have theMATLAB product installed.

® You want to update an installation of the MATLAB product that was
installed on a system with the Mac OS X product 10.1.x, but has
subsequently been updated to the Mac OS X product 10.2.

® You want to update an installation of the MATLAB product that is installed
on a system with Mac OS X 10.1.x.

® You already updated the MATLAB product installed on a system with Mac
OS X 10.1.x, as in scenario III above, and have subsequently updated to
Mac OS X 10.2.
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Depending on which scenario you choose, please follow the directions below.

The first step is to download the MathWorks Jaguar® Updater disk image
from ftp://ftp.mathworks.com/pub/tech-support/solutions/s33053.
This file is named MathWorks_Jaguar_Updater.dmg. Place this file on your
desktop. Double-click the file to start the Disk Copy utility, which will mount
the disk image as a virtual disk named MathWorks_dJaguar_Updater. You
will use this MathWorks_dJaguar_Updater virtual disk in the following
installations.

Next, locate your scenario and follow the steps listed for that scenario.

Scenario . You want to install MATLAB Release 13 on a Mac OS X 10.2
system that does not currently have the MATLAB product installed.

1 Insert the MATLAB Release 13 install CD titled CD 1 of 3 into your CD
drive.

2 Wait a few moments for Mac OS X to mount the CD. When the
MathWorks_R13_1 volume appears on your desktop, you can proceed.

3 Double-click on the Install for Mac OS X icon in the
MathWorks_dJaguar_Updater virtual disk.

4 Follow the instructions presented by the installer.

5 After the installer finishes, drag the MathWorks_R13_1 volume to the
trash to eject the CD, and repeat steps 1 through 4 with CD 2 of 3 and
CD 3 of 3.

Scenario Il. You want to update an installation of the MATLAB product that
was installed on a system with Mac OS X 10.1.x, but has subsequently been
updated to Mac OS X 10.2.

1 Double-click on the XFree86_4.2.0.1-10.2 icon in the
MathWorks_dJaguar_Updater virtual disk.

2 Follow the instructions presented by the XFree86 updater. Accept any
default values presented.
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3 Double-click on the MATLABR13_Jaguar_patch icon in the
MathWorks_Jaguar_Updater virtual disk.

4 Follow the instructions presented by the MATLAB updater. When
asked to choose the folder where the MATLAB product is installed click
Next unless the MATLAB product is not installed the default location
(/Applications/MATLAB6pS5). If the MATLAB product is not installed in
the default location, click the Choose... button and navigate to the folder
where you installed the MATLAB product.

Scenario lll. You want to update an installation of the MATLAB product
that is installed on a system with Mac OS X 10.1.x.

1 Double-click on the MATLABR13_Jaguar_patch icon in the
MathWorks_dJaguar_Updater virtual disk.

2 Follow the instructions presented by the MATLAB updater. When
asked to choose the folder where the MATLAB product is installed click
Next unless the MATLAB product is not installed the default location
(/Applications/MATLAB6pS5). If this is the case, then click the Choose...
button and navigate to the folder where you installed the MATLAB product.

Scenario IV. You already updated the MATLAB product installed on a
system with Mac OS X 10.1.x, as in scenario IIT above, and have subsequently
updated to Mac OS X 10.2.

1 Double-click on the XFree86 4.2.0.1-10.2 icon in the
MathWorks_dJaguar_Updater virtual disk.

2 Follow the instructions presented by the XFree86 updater. Accept any
default values presented.
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Version 3.0 (R13) Virtual Reality Toolbox

This table summarizes what’s new in Version 3.0 (R13):

New Features and | Version Fixed Bugs and Related

Changes Compatibility Known Problems Documentation at
Considerations Web Site

Yes Yes—Details labeled | No bug fixes No

Details below

as Compatibility
Considerations,
below. See also
Summary.

New features and changes introduced in this version are

Cross-Platform Support

Virtual Reality Toolbox software Version 3.0 is supported on both PC and
UNIX platforms.

Virtual Reality Toolbox Viewer

Virtual Reality Toolbox software Version 3.0 now contains a VRML viewer.
You can use this viewer on all supported operating systems. With the Virtual

Reality Toolbox viewer, you can move between predefined viewpoints in
a virtual scene. You can also control the navigation method, speed, and

rendering of the virtual world. From the MATLAB interface, you can control

the Virtual Reality Toolbox viewer better than other VRML-enabled Web
browsers.

Improved Performance

The communication between Virtual Reality Toolbox and VRML-enabled Web
browsers is improved. You are now able to perform such tasks as controlling

multiple objects in a virtual scene or setting multiple field values faster
than before.
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Improved MATLAB Interface

It is now easier to access and manipulate virtual world objects from the
MATLAB command line. You can use dot notation to change object properties.
Also, multiple field values are transferred between MATLAB and the Virtual
Reality Toolbox server in a form consistent with their VRML representation.

Customized V-Realm Object Libraries

Compatibility Considerations

If you are on a PC platform and you created your own object libraries in
V-Realm while using Virtual Reality Toolbox software Version 2.0, deleting
the MATLAB product deletes these custom libraries. You need to save these
libraries before uninstalling the older version of the MATLAB product:

1 Save the contents of the <MATLAB root>\toolbox\vr\vrealm directory
to another location on your system.

2 Uninstall the older version of the MATLAB product.
3 Install MATLAB software Version 6.5 (Release 13).
4 Install V-Realm using the command

vrinstall -install editor
5 Save the files from your old vrealm directory into the new vrealm directory.
MATLAB software Version 6.5 should have the same directory structure as
your previous version of the MATLAB product. If the directory structure is not
identical, search your system for vrbuild2.ini. Edit the relative paths within

this file to reflect the directory structure of MATLAB software Version 6.5.

After you have moved your files into the new vrealm directory and customized
your vrbuild2. ini file, do not reinstall the V-Realm editor. The command

vrinstall -install editor

replaces the existing vrbuild2.ini file with the default template file.
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Virtual Reality Toolbox Compatibility Summary

This table summarizes new features and changes that might cause
incompatibilities when you upgrade from an earlier version, or when you
use files on multiple versions. Details are provided in the description of the

new feature or change.

Version (Release)

New Features and Changes with
Version Compatibility Impact

Latest Version None
V4.8 (R2008b)

V4.7 (R2008a) None
V4.6 (R2007b) None
V4.5 (R2007a) None

V4.4 (R2006b)

See the Compatibility
Considerations subheading
for this change:

V4.3 (R20064a) None
V4.2.1 (R14SP3) None
V4.2 (R14SP2+) None
V4.1 (R14SP2) None

V4.0.1 (R14SP1)

See the Compatibility
Considerations subheading
for this change:

® “VR Source block” on page 17
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Version (Release)

New Features and Changes with
Version Compatibility Impact

V4.0 (R14) None
V3.1 (R13SP1) None
V3.0 (R13) See the Compatibility

Considerations subheading
for this change:

e “Customized V-Realm Object
Libraries” on page 36
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